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サーバ アプリケーションのインストールと
アップグレード

次のトピックで、Security Manager サーバ ソフトウェアとその他のサーバ アプリケーション

（Common Services、AUS、Performance Monitor、RME など）のインストール方法について説明しま

す。

• 「必要なサーバ ユーザ アカウントについて」（P.4-1）

• 「Remote Desktop Connection または VNC を使用したサーバ アプリケーションのインストール」

（P.4-2）

• 「Security Manager サーバ、Common Services、および AUS のインストール」（P.4-3）

• 「Performance Monitor のインストール」（P.4-5）

• 「Resource Manager Essentials（RME）のインストール」（P.4-7）

• 「サーバ アプリケーションのアップグレード」（P.4-9）

• 「新しいコンピュータまたはオペレーティング システムへの Security Manager の移行」（P.4-17）

• 「Security Manager、Performance Monitor、および RME ライセンスの更新」（P.4-18）

• 「サービス パックとポイント パッチの入手」（P.4-19）

• 「サーバ ホームページへのアプリケーションの追加」（P.4-20）

• 「サーバ アプリケーションのアンインストール」（P.4-20）

必要なサーバ ユーザ アカウントについて
CiscoWorks Common Services と Security Manager は、必要な認可を受けているユーザにのみ特定の

機能へのアクセスを許可する多層セキュリティ システムを採用しています。そのため、Common 
Services 上で動作するアプリケーションがインストールされたシステム上では事前に定義された次の 3 
つのユーザ アカウントが作成されます。

• admin：admin ユーザ アカウントは、Windows 管理者と等価で、Common Services、
Security Manager、およびその他のアプリケーション タスクのすべてにアクセスできるようにしま

す。インストール中にパスワードを入力する必要があります。このアカウントは、初めてサーバに

ログインするときに使用して、アプリケーションを日常的に使用するための他のユーザ アカウン

トを作成できます。

• casuser：casuser ユーザ アカウントは、Windows 管理者と等価で、Common Services タスクと 
Security Manager タスクのすべてにアクセスできるようにします。このアカウントを直接使用する

ことはあまりありません。
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第 4 章      サーバ アプリケーションのインストールとアップグレード

    Remote Desktop Connection または VNC を使用したサーバ アプリケーションのインストール
製品のインストール中に設定された casuser（デフォルト サービス アカウント）権限またはディレ

クトリ権限を変更しないでください。変更した場合は、次の操作ができなくなる可能性がありま

す。

– Web サーバへのログイン 

– クライアントへのログイン 

– データベースの正常なバックアップ 

• システム識別：システム識別ユーザ アカウントは、Windows 管理者と等価で、Common Services 
タスクと Security Manager タスクのすべてにアクセスできるようにします。このアカウントには

固定の名前がありません。ニーズに合った名前を使用してアカウントを作成できます。Common 
Services でアカウントを作成した場合は、そのアカウントにシステム管理者特権を付与する必要が

あります。ユーザ認証に Cisco Secure Access Control Server（ACS）を使用している場合は、

ACS にすべての特権を付与する必要があります。

Cisco Security Management Suite アプリケーションを別のサーバにインストールする場合（推奨ア

プローチ）は、マルチサーバ セットアップ内のすべてのサーバ上で同じシステム識別ユーザ アカ

ウントを作成する必要があります。サーバ間の通信は、証明書と共有秘密キーを使用する信頼モデ

ルに依存します。システム識別ユーザは、マルチサーバ セットアップ内の他のサーバから信頼で

きるアカウントと見なされるため、ドメイン内のサーバ間通信が容易になります。

必要な数のユーザ アカウントを追加できます。アカウントはユーザごとに一意にする必要があります。

このような追加のアカウントを作成するには、システム管理者権限（admin アカウントの使用など）を

持っている必要があります。ユーザ アカウントを作成したら、それにロールを割り当てる必要があり

ます。このロールによって、表示も含めて、ユーザがアプリケーション内で可能な操作が定義されま

す。使用可能な権限の種類と ACS を使用してアプリケーションへのアクセスを制御する方法について

は、第 7 章「ユーザ アカウントの管理」を参照してください。

Remote Desktop Connection または VNC を使用した
サーバ アプリケーションのインストール

サーバ アプリケーションは、直接サーバにログインしてインストールすることを推奨します。

ただし、リモート インストール（別のワークステーション経由のログイン）を行わなければならない

場合は、次のヒントを考慮してください。

• リモート ディスクからソフトウェアをインストールしようとしないでください。ソフトウェア イ
ンストーラは、サーバ内の DVD ドライブ上で動作している製品 DVD 上に存在するか、直接接続

されたディスク ドライブ上に存在する必要があります。リモート ディスクからのインストールが

成功したように見える場合がありますが、実際には成功していません。

• ソフトウェアのインストールに Virtual Network Computing（VNC）を使用できます。

• ソフトウェアのインストールに Remote Desktop Connection を使用できます。ただし、複数の 
Remote Desktop Connection セッションが同時に開いているときに Security Manager をインストール

しようとすると、Cisco Security Agent が自動的に停止しないことがあります。これは、Remote 
Desktop Connection セッションを最初に開いた管理者が、必ず、Cisco Security Agent サービスの停

止に関する問い合わせを受け取るという Remote Desktop Connection の制限によるものです。

Remote Desktop Connection セッション上で Security Manager をインストールしたが、最初にログイ

ンした管理者でない場合は、問い合わせを受け取れません。回避策は、Security Manager をインス

トールする前に net stop CSAgent コマンドを入力することです。または、インストール中に、最初

または唯一の Remote Desktop Connection セッションを所有することです。
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第 4 章      サーバ アプリケーションのインストールとアップグレード

    Security Manager サーバ、Common Services、および AUS のインストール
Security Manager サーバ、Common Services、および 
AUS のインストール

メインの Security Manager インストール プログラムで次のようなアプリケーションをインストールで

きます。

• CiscoWorks Common Services 3.3：すべてのサーバ アプリケーションに必要な基盤ソフトウェア

です。Security Manager、AUS、Performance Monitor、または RME をインストールする場合は、

Common Services 3.3（まだインストールされていない場合）をインストールする必要がありま

す。

• Cisco Security Manager 4.0：Security Manager のメイン サーバ ソフトウェアです。

サーバにフル スタンドアロン バージョンの Cisco Security Agent がインストールされていない場

合は、インストール プログラムが次のように対処します。

– Windows 2003 R2 Enterprise Server（Service Pack 2）（32 ビット）では、インストール プロ

グラムから Cisco Security Agent をインストールするかどうかが尋ねられます。

– Windows 2008 Enterprise Server（Service Pack 2）（32 ビット）では、インストール プログラ

ムが Cisco Security Agent をインストールしません。

– Windows 2008 Enterprise Server（Service Pack 2）（64 ビット）では、インストール プログラ

ムが Cisco Security Agent をインストールしません。

• Auto Update Server 4.0

• Cisco Security Manager Client 4.0：Security Manager サーバとデータをやり取りするためのクラ

イアント ソフトウェア。サーバと同じコンピュータ上にインストールできますが、このセット

アップを Security Manager を使用する通常の方法として使用しないでください。推奨されている

クライアントのインストールとセットアップの詳細については、第 5 章「クライアントのインス

トールと設定」を参照してください。

次の手順を使用して、これらのアプリケーションをインストールまたは再インストールします。以前の

バージョンのアプリケーションからアップグレードしている場合は、先に進む前に、「サーバ アプリ

ケーションのアップグレード」（P.4-9）を参照してください。

始める前に

• （従来の）Security Manager 3.x リリースの有効なライセンスを持っているかどうかに関係なく、す

べてのお客様が Security Manager 4.0 の新しいライセンスを取得する必要があります。増分ライセ

ンスを除いて、既存の Security Manager 3.x ライセンスは Security Manager 4.0 に使用できません。

• すでにサーバ上にインストールされている既存のバージョンのアプリケーションに対するアップグ

レードとして製品をインストールしている場合は、「リモート アップグレード時のデータベースの

バックアップ」（P.4-13）に記載されているようにバックアップを実行してください。アップグ

レードをインストールする前に、バックアップが正常に終了し、既存のアプリケーションが正しく

機能していることを確認してください。

• Security Manager の永久ライセンスを持っている場合は、それをサーバにコピーします。インス

トール中にライセンス ファイルを選択するためには、それがサーバ上に存在している必要があり

ます。そのファイルは製品をインストールするフォルダに配置しないでください。

• 「インストール準備状況チェックリスト」（P.3-4）を完了したことを確認してください。

• サーバが「サーバ要件」（P.2-3）に記載された要件を満たしていることを確認してください。

• Security Manager は制御環境下の専用サーバにインストールすることを推奨します。他のソフト

ウェア アプリケーションをインストールした場合は、Security Manager の通常動作と競合したり、

サポートされていなかったりする可能性があります。
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第 4 章      サーバ アプリケーションのインストールとアップグレード

    Security Manager サーバ、Common Services、および AUS のインストール
• Security Manager サーバまたは AUS のインストール後に Common Services を再インストールし

た場合は、Security Manager または AUS も再インストールする必要があります。

• Common Services のインストール後にシステム時間を変更しないでください。このような変更が

一部の時間依存機能の動作に影響する可能性があります。

• Cisco Secure Access Control Server（ACS）を使用して、Security Manager または AUS へのユー

ザ アクセスに AAA サービスを提供する場合は、アプリケーションをインストールしてから、

ACS を使用するように Common Services を設定します。ACS 制御の設定方法については、

「Security Manager と Cisco Secure ACS の統合」（P.7-8）を参照してください。

ACS を使用するように Common Services を設定してから Security Manager または AUS をインス

トールした場合は、インストール中に、インストールしたアプリケーションを ACS に登録する必

要があることが通知されます。まだアプリケーション（このサーバ上または別のサーバ上）を 
ACS に登録していない場合は、[Yes] を選択します。すでにアプリケーションを登録している場合

は、[Yes] を選択すると、アプリケーションの ACS 内で設定されたユーザ ロールのカスタマイズ

が失われるため、[No] を選択する必要があります。同じ ACS サーバを使用するすべての Security 
Manager サーバと AUS サーバがユーザ ロールを共有します。

手順

Security Manager サーバ、Common Services、AUS、またはメインの Security Manager インストール 
プログラムを使用する複数のアプリケーションをインストールするには、次の手順を実行します。

ステップ 1 インストール プログラムを入手または検索します。次のいずれかの操作を実行できます。

• サーバの DVD ドライブに Security Manager インストール DVD を挿入します。インストール アプ

リケーションが自動的に起動しなかった場合は、csm<version>_win_server フォルダ内の 
Setup.exe ファイルを実行します。

• Cisco.com アカウントにログインして、http://www.cisco.com/go/csmanager にある Security 
Manager ホームページにアクセスします。[Download Software] をクリックして、圧縮された 
Security Manager のインストール ファイルをダウンロードします。

– WinZip や圧縮フォルダの展開ウィザードなどの Windows Server 2003 に付属しているファイ

ル圧縮ユーティリティのいずれかを使用して、圧縮されたソフトウェア インストール ファイ

ル内のすべてのファイルを一時ディレクトリで解凍します。パス名があまり長くないディレク

トリを使用してください。たとえば、C:¥Documents and Settings¥Administrator¥Desktop よ
りは C: を選択してください。通常は、圧縮ファイルと同じディレクトリに解凍されるインス

トール プログラムの Setup.exe を開始します。

– ファイルの内容を解凍できないというエラー メッセージが表示された場合は、Temp ディレク

トリを空にして、ウイルスをスキャンし、C:¥Program Files¥Common Files¥InstallShield ディ

レクトリを削除してから、リブートしてもう一度試してみてください。

ステップ 2 インストール ウィザードの指示に従います。インストール中に、次の情報の入力が要求されます。

• Backup location：特定のバージョンの Common Services、Security Manager、または AUS がすで

にインストールされている場合は、インストール プログラムによってインストール中のデータ

ベース バックアップが許可されます。バックアップを実施する場合は、バックアップに使用する

場所を選択します。ただし、バックアップは、インストールを開始する前に実施することを推奨し

ます。

• Destination folder：アプリケーションをインストールするフォルダ。他の場所にインストールする

特別な理由がなければ、デフォルトを受け入れます。デフォルト フォルダ以外のフォルダを指定

した場合は、その下にファイルが存在しないことと、パス名が 256 文字未満であることを確認して

ください。
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第 4 章      サーバ アプリケーションのインストールとアップグレード

    Performance Monitor のインストール
• Applications：インストールするアプリケーション。まだ Common Services がインストールされ

ていない場合は、Common Services を選択して Security Manager または AUS をインストールする

必要があります。

• License information：次のいずれかを選択します。

– License File Location：ライセンス ファイルのフル パス名を入力するか、[Browse] をクリッ

クして検索します。永久ライセンス ファイルを事前にサーバ上に配置してあった場合は、そ

のファイルを指定できます。

– Evaluation Only：無料の 90 日の評価期間をイネーブルにします。

• Admin password：5 文字以上の admin ユーザ アカウント用パスワード。このアカウント、システ

ム識別アカウント、および casuser アカウントの詳細については、「必要なサーバ ユーザ アカウン

トについて」（P.4-1）を参照してください。

• System Identity user：システム識別ユーザとして使用するアカウントのユーザ名とパスワード。

Cisco Security Management Suite アプリケーションを複数のサーバ上にインストールする場合は、

すべてのサーバ上で同じシステム識別ユーザ アカウントを使用してください。

• Create casuser：新しいインストールで casuser アカウントを作成するかどうか。このユーザ アカ

ウントは作成する必要があります。

ステップ 3 インストールの完了後に、サーバが自動的に再起動しない場合は、サーバを再起動します。

（注） インストール後の再起動中は、不定期かつランダムに、Windows on VMware ESX が応答を停止（ス

トール）します。この場合は、VMware GUI コントロールを使用して VMware ESX のインスタンスを

リブートします。

Performance Monitor のインストール
Performance Monitor 4.0 は以下の場所にインストールできます。

• CiscoWorks Common Services 3.3 のインストール後のスタンドアロン サーバ。これが推奨されて

いる設定です。

• CiscoWorks Common Services 3.3 のインストール後の Security Manager、AUS、RME のいずれ

かまたは全部をインストールしたサーバ。ただし、Event Management を使用またはイネーブルに

する場合は、「Event Management のイネーブル化の影響」（P.1-8）を参照してください。Security 
Manager サーバ上で MCP または RME に関する syslog を使用する場合は、そのサーバ上で Event 
Management をイネーブルにできません。

ヒント この設定は、小規模ネットワークにのみ推奨されています。

Performance Monitor ライセンスは、Security Manager ライセンス ファイルとは別のファイルであり、

RME 4.3 のライセンスも含まれています。ライセンスは、Performance Monitor のインストールの前と

後のどちらでもインストールできます。ライセンス ファイルの取得手順については、「インストールに

対するライセンスの影響とライセンスの取得」（P.1-6）を参照してください。
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    Performance Monitor のインストール
始める前に

すでに Performance Monitor、Common Services、またはその他の CiscoWorks アプリケーションが存

在するシステム上にインストールしている場合は、サーバ上に Performance Monitor をインストールす

る前に次の推奨事項を考慮してください。

• Performance Monitor の永久ライセンスを持っている場合は、それをサーバにコピーします。イン

ストール中にライセンス ファイルを選択するためには、それがサーバ上に存在している必要があ

ります。

• Common Services をバックアップします。バックアップには、Common Services を使用するすべ

てのインストール済みアプリケーションに関するデータが含まれています。Performance Monitor 
インストール プログラムは、インストール中のバックアップを実施しません。バックアップの実

施方法については、「リモート アップグレード時のデータベースのバックアップ」（P.4-13）を参照

してください。

• Common Services と Performance Monitor を 1 台のサーバ上にインストールしてから、後で、

Common Services を再インストールした場合は、Performance Monitor も再インストールする必要

があります。

• Cisco Secure Access Control Server（ACS）を使用して、Performance Monitor へのユーザ アクセ

スに AAA サービスを提供する場合は、Performance Monitor をインストールしてから、ACS を使

用するように Common Services を設定します。ACS 制御の設定方法については、「Security 
Manager と Cisco Secure ACS の統合」（P.7-8）を参照してください。

ACS を使用するように Common Services を設定してから Performance Monitor をインストールし

た場合は、インストール中に、インストールしたアプリケーションを ACS に登録する必要がある

ことが通知されます。まだ Performance Monitor（このサーバ上または別のサーバ上）を ACS に
登録していない場合は、[Yes] を選択します。すでに Performance Monitor を登録している場合は、

[Yes] を選択すると、アプリケーションの ACS 内で設定されたユーザ ロールのカスタマイズが失

われるため、[No] を選択する必要があります。同じ ACS サーバを使用するすべての Performance 
Monitor サーバがユーザ ロールを共有します。

次の手順には、ACS を使用するように Common Services を設定した後に Performance Monitor を
インストールする場合に従うべき追加の手順が含まれています。

手順 
Performance Monitor をインストールするには、次の手順を実行します。

ステップ 1 すでにサーバに CiscoWorks Common Services 3.3 がインストールされている場合は、Security 
Manager インストール DVD を使用して Common Services をインストールします。インストール手順

については、「Security Manager サーバ、Common Services、および AUS のインストール」（P.4-3）を

参照してください。Performance Monitor は Common Services 3.3 がなければ機能できません。また、

Performance Monitor をインストールする前に、Common Services をインストールするか、バージョン 
3.3 にアップグレードする必要があります。

ステップ 2 インストール プログラムを入手または検索します。次のいずれかの操作を実行できます。

• サーバの DVD ドライブに Security Manager インストール DVD を挿入します。インストール プロ

グラムは mcp<version>¥Setup.exe です。

• Cisco.com アカウントにログインして、http://www.cisco.com/go/csmanager にある Security 
Manager ホームページにアクセスします。[Download Software] をクリックして、

Performance Monitor のインストール ユーティリティをダウンロードします。

ステップ 3 インストールを開始するには、インストール プログラムをダブルクリックしてから、プロンプトに従

います。
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第 4 章      サーバ アプリケーションのインストールとアップグレード

    Resource Manager Essentials（RME）のインストール
ステップ 4 ライセンス情報を選択するように要求されたら、次のいずれかを選択します。

• License File Location：ライセンス ファイルのフル パス名を入力するか、[Browse] をクリックし

て検索します。永久ライセンス ファイルをサーバ上に配置してあった場合は、そのファイルを指

定できます。

• Evaluation Only：無料の 90 日の評価期間をイネーブルにします。

Performance Monitor と ACS
まだ ACS を使用するように Common Services を設定していない場合は、この手順の残りのステップを

省略します。ただし、ACS を使用するように Common Services を設定してから Performance Monitor 
をインストールする場合は、この手順の追加のステップを完了する必要があります。

ステップ 5 ACS サーバにログインします。

ステップ 6 ACS サーバ上で、[Shared Profile Components] に移動します。Performance Monitor がアプリケー

ション リストに掲載されていることを確認します。

ステップ 7 ACS サーバ上で、[Group Setup] に移動します。Security Manager の設定に使用したグループ名を選択

します。

ステップ 8 [Edit Settings] をクリックします。

ステップ 9 [Group Setup] ページで、MCP を探します。チェックボックスをオンにして、ACS 統合用の 
Performance Monitor を含めます。

ステップ 10 また、[Group Setup] ページ上で、次のセクション（Performance Monitor）に移動します。

ステップ 11 [Assign a Performance Monitor on a per Network Device Group Basis] オプション ボタンをクリックし

ます。

ステップ 12 [Device Group] ドロップダウン メニューで、[CSM_Servers] を選択します。

ステップ 13 [Performance Monitor] ドロップダウン メニューで、[System Administrator] を選択します。

ステップ 14 [Submit + Restart] をクリックします。

ステップ 15 CSM サーバ上で、Daemon Manager を再起動します。

ステップ 16 数分間待って、デーモンの開始を確認してから、MCP サーバにログインします。

Resource Manager Essentials（RME）のインストール
RME 4.3 は以下の場所にインストールできます。

• CiscoWorks Common Services 3.3 のインストール後のスタンドアロン サーバ。これが推奨されて

いる設定です。

• CiscoWorks Common Services 3.3 のインストール後に Security Manager、AUS、MCP のいずれ

かまたは全部をインストールしたサーバ。ただし、Event Management を使用またはイネーブルに

する場合は、「Event Management のイネーブル化の影響」（P.1-8）を参照してください。Security 
Manager サーバ上で RME または MCP に関する syslog を使用する場合は、そのサーバ上で Event 
Management をイネーブルにできません。

ヒント この設定は、小規模ネットワークにのみ推奨されています。
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RME ライセンスは、Security Manager ライセンス ファイルとは別のファイルであり、Performance 
Monitor のライセンスも含まれています。ライセンスは、RME のインストールの前と後のどちらでも

インストールできます。ライセンス ファイルの取得手順については、「インストールに対するライセン

スの影響とライセンスの取得」（P.1-6）を参照してください。

始める前に

すでに RME、Common Services、またはその他の CiscoWorks アプリケーションが存在するシステム

上にインストールしている場合は、サーバ上に RME をインストールする前に次の推奨事項を考慮して

ください。

• RME の永久ライセンスを持っている場合は、それをサーバにコピーします。インストール中にラ

イセンス ファイルを選択するためには、それがサーバ上に存在している必要があります。

• Common Services をバックアップします。バックアップには、Common Services を使用するすべ

てのインストール済みアプリケーションに関するデータが含まれています。RME インストール プ
ログラムは、インストール中のバックアップを実施しません。バックアップの実施方法について

は、「リモート アップグレード時のデータベースのバックアップ」（P.4-13）を参照してください。

• Common Services と RME を 1 台のサーバ上にインストールしてから、後で、Common Services 
を再インストールした場合は、RME も再インストールする必要があります。

• Cisco Secure Access Control Server（ACS）を使用して、RME へのユーザ アクセスに AAA サー

ビスを提供する場合は、RME をインストールしてから、ACS を使用するように Common 
Services を設定します。ACS 制御の設定方法については、「Security Manager と Cisco Secure 
ACS の統合」（P.7-8）を参照してください。

ACS を使用するように Common Services を設定してから RME をインストールした場合は、イン

ストール中に、インストールしたアプリケーションを ACS に登録する必要があることが通知され

ます。まだ RME（このサーバ上または別のサーバ上）を ACS に登録していない場合は、[Yes] を
選択します。すでに RME を登録している場合は、[Yes] を選択すると、アプリケーションの ACS 
内で設定されたユーザ ロールのカスタマイズが失われるため、[No] を選択する必要があります。

同じ ACS サーバを使用するすべての RME サーバがユーザ ロールを共有します。

手順 
RME をインストールするには、次の手順を実行します。

ステップ 1 すでにサーバに CiscoWorks Common Services 3.3 がインストールされている場合は、Security 
Manager インストール DVD を使用して Common Services をインストールします。インストール手順

については、「Security Manager サーバ、Common Services、および AUS のインストール」（P.4-3）を

参照してください。RME は Common Services 3.3 がなければ機能できません。また、RME をインス

トールする前に、Common Services をインストールするか、バージョン 3.3 にアップグレードする必

要があります。

RME をインストールする前に Common Services をインストールしてシステムを再起動しないと、

Common Services のインストールが失敗する可能性があります。

ステップ 2 インストール プログラムを入手または検索します。次のいずれかの操作を実行できます。

• サーバの DVD ドライブに Security Manager インストール DVD を挿入します。インストール プロ

グラムは rme<version>¥Setup.exe です。

• Cisco.com アカウントにログインして、http://www.cisco.com/go/csmanager にある Security 
Manager ホームページにアクセスします。[Download Software] をクリックして、RME のインス

トール ユーティリティをダウンロードします。

ステップ 3 McAfee VirusScan がサーバ上にインストールされている場合は、VirusScan とその「オンアクセス ス
キャン」機能が動作していることを確認してください。
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VirusScan がインストールされているが、オフになっている場合、または、そのオンアクセス スキャン

機能がオフになっていた場合は、RME をインストールできない可能性があります。加えて、この理由

で RME のインストールが失敗した場合は、同じサーバにインストールされた Security Manager が正

しく動作しない可能性があります（Security Manager を再インストールする必要があります）。

ステップ 4 インストールを開始するには、インストール プログラムをダブルクリックしてから、プロンプトに従

います。

インストール中に、次の情報の入力が要求されます。

• License information：次のいずれかを選択します。

– License File Location：ライセンス ファイルのフル パス名を入力するか、[Browse] をクリッ

クして検索します。永久ライセンス ファイルを事前にサーバ上に配置してあった場合は、そ

のファイルを指定できます。

– Evaluation Only：無料の 90 日の評価期間をイネーブルにします。

• Setup type（Typical または Custom）：[Typical] を選択します。標準とカスタムの違いは、カスタ

ム インストールで標準インストール中にランダムに生成されたデータベース パスワードを指定で

きることだけです。データベース パスワードを指定する場合は、5 ～ 15 文字を使用し、先頭は数

字以外に、文字間にスペースを挿入しないようにしてください。このパスワードは、データベース

の復元やトラブルシューティングにも使用されます。

• Restart CiscoWorks Daemons：CiscoWorks デーモンを再起動するかどうかが尋ねられます。[Yes] 
を選択します。

サーバ アプリケーションのアップグレード
アプリケーションのアップグレードとは、古いバージョンからのデータを維持しながら、新しいバー

ジョンのアプリケーションをインストールするプロセスです。3 種類のアップグレード パスがありま

す。

• ローカル：古いバージョンをアンインストールせずに、古いバージョンを実行中のサーバ上に新し

いバージョンをインストールします。既存のデータが保存され、新しくインストールされたバー

ジョンで使用できます。ローカル アップグレードを実施する場合は次の点に注意してください。

– この方式を使用する前に、アップグレードするすべてのアプリケーションが正しく機能してい

ることを確認してください。また、アップグレード対象のアプリケーションをインストールす

る前に、データベースのバックアップを実施して、正常に終了したことを確認してください。

– サーバ上のオペレーティング システムもアップグレードしている場合、たとえば、Windows 
2003 から Windows 2008 にアップグレードしている場合は、この方式が使用できません。オ

ペレーティング システムのアップグレードも行いながら Security Manager をアップグレード

している場合は、代わりに、リモート バックアップ /復元アップグレード方式を使用します。

同じ Security Manager リリースを維持しながらオペレーティング システムをアップグレード

している場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.4-17）に記載された手順を実行します。

• リモート（バックアップ /復元）：新しいバージョンをクリーン サーバ（古いアプリケーションが

インストールされていないサーバ）にインストールしてから、古いバージョンから作成したバック

アップからデータベースを復元します。新しいサーバ上にインストールする場合、または、インス

トールを実施する前にサーバをクリーンオフする（アプリケーションをアンインストールする前に

バックアップを作成する）場合に、この手順を使用します。
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（注） Security Manager サーバ アプリケーションを実行しているサーバのバックアップを作成す

る前に、すべての保留データがコミットされていることを確認する必要があります。

「Security Manager の保留データが送信および承認されることの保証」（P.4-12）を参照し

てください。

• 間接：ローカルまたはリモート アップグレードでサポートされていない古いバージョンのアプリ

ケーションを使用している場合は、2 段階プロセスを実行する必要があります。ローカルまたはリ

モート アップグレードでサポートされているバージョンにアップグレードしてから、ローカルま

たはリモート アップグレードを実施します。中間のバージョンを Cisco.com からダウンロードし

ます。

使用中のバージョンが下の表に間接アップグレード用として掲載されておらず、古いデータを保存

する必要がある場合は、3 つ以上の中間アップグレード手順を実施する必要があります。たとえ

ば、Performance Monitor 3.0 からアップグレードする場合は、まず、3.2 にアップグレードしてか

ら、3.3 にアップグレードし、4.0 にアップグレードする必要があります。また、Security Manager 
3.0.x の場合は、3.1.1 にアップグレードしてから、3.3 にアップグレードし、4.0 にアップグレード

する必要があります。

通常、以前のバージョンのアプリケーションからアップグレードする場合は、評価ライセンスと永久ラ

イセンスの両方が保存されます。ただし、（従来の）Security Manager 3.x リリースの有効なライセン

スを持っているかどうかに関係なく、すべてのお客様が Security Manager 4.0 の新しいライセンスを取

得する必要があります。増分ライセンスを除いて、既存の Security Manager 3.x ライセンスは Security 
Manager 4.0 に使用できません。

表 4-1 に、アップグレード パスごとにサポートされているソフトウェアのバージョンに関する説明を

示します。
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表 4-1 アプリケーション アップグレード パス

アップグ

レード パ
ス アプリケーション

サポートされている

古いバージョン アップグレード手順

ローカル Security Manager 4.0

Auto Update Server 4.0

3.2.2、3.3、および 
3.3.1

すべての保留データをコミットします。「Security Manager 
の保留データが送信および承認されることの保証」

（P.4-12）を参照してください。

その後で、ソフトウェアをインストールします。「Security 
Manager サーバ、Common Services、および AUS のイン

ストール」（P.4-3）を参照してください。

最後に、アップグレード後の必要な変更を加えます。「アッ

プグレード後の必要な変更の実施」（P.4-16）を参照してく

ださい。

Performance Monitor 4.0 3.2.2、3.3、および 
3.3.1

（推奨）データベースをバックアップします。「リモート 
アップグレード時のデータベースのバックアップ」

（P.4-13）を参照してください。

その後で、ソフトウェアをインストールします。

「Performance Monitor のインストール」（P.4-5）を参照し

てください。

RME 4.3 4.2 （推奨）データベースをバックアップします。「リモート 
アップグレード時のデータベースのバックアップ」

（P.4-13）を参照してください。

その後で、ソフトウェアをインストールします。「Resource 
Manager Essentials（RME）のインストール」（P.4-7）を

参照してください。

リモート Security Manager 4.0

Auto Update Server 4.0

3.2.2、3.3、および 
3.3.1

1. データベースをバックアップします。「リモート アップ

グレード時のデータベースのバックアップ」（P.4-13）
を参照してください。

2. アプリケーションをインストールします。次の項を参

照してください。

「Security Manager サーバ、Common Services、および 
AUS のインストール」（P.4-3）

「Performance Monitor のインストール」（P.4-5）

「Resource Manager Essentials（RME）のインストー

ル」（P.4-7）

3. 必要に応じて、データベースのバックアップをサーバ

に転送します。

4. データベースを回復します。「サーバ データベースの復

元」（P.4-15）を参照してください。

5. 最後に、アップグレード後の必要な変更を加えます。

「アップグレード後の必要な変更の実施」（P.4-16）を

参照してください。

Performance Monitor 4.0 3.2.2、3.3、および 
3.3.1

RME 4.3 4.2
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Security Manager の保留データが送信および承認されることの保証

Security Manager のアップグレードを成功させるためには、既存の Security Manager データベースに

保留データが含まれていないことを保証する必要があります。保留データとは、データベースに対して

コミットされていないデータのことです。保留データが残っている以前のバージョンの Security 
Manager からのデータベースは復元できません。復元できるのは、バックアップと同じバージョンを

実行しているシステム上に保留データが残っているデータベースだけです。

ユーザごとに変更を送信または破棄する必要があります。アプルーバでワークフロー モードを使用し

ている場合は、このような送信も承認する必要があります。すべてのデバイス設定と Security 
Manager データベースを同期させるためには、すべてのデータのコミット後に展開を実施する必要も

あります。

• 非ワークフロー モードの場合：

– 変更をコミットするには、[File] > [Submit] を選択します。

– コミットされていない変更を破棄するには、[File] > [Discard] を選択します。

– 他のユーザの変更をコミットまたは破棄する必要がある場合は、そのユーザのセッションを引

き継ぐことができます。セッションを引き継ぐには、[Tools] > [Security Manager 
Administration] > [Take Over User Session] を選択してから、[Take Over Session] をクリック

します。

• ワークフロー モードの場合：

– 変更をコミットして承認するには、[Tools] > [Activity Manager] を選択します。[Activity 
Manager] ウィンドウで、アクティビティを選択して、[Approve] を選択します。アクティビ

ティ アプルーバを使用している場合は、[Submit] をクリックして、アプルーバにアクティビ

ティを承認させます。

– コミットされていない変更を破棄するには、[Tools] > [Activity Manager] を選択します。

[Activity Manager] ウィンドウで、アクティビティを選択してから、[Discard] を選択します。

Edit 状態または Edit Open 状態のアクティビティしか破棄できません。

間接 Security Manager 4.0 3.1、3.1.1、3.2、お

よび

3.2.1

3.2.2 にアップグレードしてから、3.2.2 のインストレー

ション ガイドのアップグレードに関する章内のデータ移行

手順を忠実に実行します。

その後で、ローカルまたはリモート アップグレード パスを

使用します。

Performance Monitor 4.0 3.1、3.2、または 
3.2.1 

3.2.2 バージョンにアップグレードしてから、ローカルまた

はリモート アップグレード パスを使用します。3.2.2 のイ

ンストーレション ガイドを参照してください。

RME 4.3 該当なし 該当なし。サポートされる最新の RME リリースは 4.0.3 で
す。

これはローカルまたはリモート アップグレードでサポート

されます。

表 4-1 アプリケーション アップグレード パス （続き）

アップグ

レード パ
ス アプリケーション

サポートされている

古いバージョン アップグレード手順
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プロパティ ファイルに対する変更の復元 
すべての Security Manager インストールにいくつかのプロパティ ファイルが含まれています。この

ファイルには、使用中に変更されたデータが保存されます。

• $NMSROOT¥MDC¥athena¥config¥csm.properties

• $NMSROOT¥MDC¥athena¥config¥DCS.properties

• $NMSROOT¥MDC¥athena¥config¥taskmgr.prop 

ヒント $NMSROOT は、Common Services インストール ディレクトリ（デフォルトは C:¥Program 
Files¥CSCOpx）のフル パス名です。

現在のインストールに対してサービス パックのアップグレードまたはインストールを実施した場合の 
Security Manager の動作は次のとおりです。

• アップグレードまたはサービス パックに関連する新しいファイルをインストールします。

• 新しいファイルと使用中に変更されたファイルを比較します。

• 新しいファイルと使用中に変更されたファイルが異なる場合は警告を発します。その場合は、

Security Manager が次のように処理します。

– 使用中に変更されたファイルを <filename>.org という名前で保存します。

– 参考用として、差分ファイルを <filename>.diff という名前で保存します。

新しいファイルと使用中に変更されたファイルが異なるという内容の警告を受け取った場合は、

<filename>.org と <filename>.diff 内の情報を使用して、アップグレードまたはサービス パックのイン

ストール前に、加えた変更をプロパティ ファイルに復元します。

リモート アップグレード時のデータベースのバックアップ

CiscoWorks Common Services は、データベースのバックアップと復元に使用される Common 
Services バックアップ /復元ユーティリティで、すべてのサーバ アプリケーションのデータベースを管

理します。そのため、バックアップを作成すると、サーバ上にインストールされたすべての 
CiscoWorks アプリケーションのバックアップが作成されます。

ヒント このバックアップ手順はデータベースのみをバックアップします。イベント データ ストアをバック

アップする必要がある場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.4-17）に記載されているデータ ストア コピー手順を使用します。

ステップ 1 Security Manager を実行しているサーバをバックアップしている場合は、Security Manager クライア

ントの [Tools] > [Backup] というショートカットを使用してバックアップ ページを表示できます。ま

た、保留データがコミットされていることを確認します（「Security Manager の保留データが送信およ

び承認されることの保証」（P.4-12）を参照）。

Security Manager を実行していないサーバの場合は、次の手順でバックアップ ページを表示します。

a. サーバ上の Cisco Security Management Server デスクトップにログインします（「Web ブラウザを

使用したサーバ アプリケーションへのログイン」（P.5-11）を参照）。

b. [Server Administration] パネルをクリックします。[Server] > [Admin] タブで CiscoWorks 
Common Services が開きます
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（CiscoWorks ホームページにログインした場合は、[Common Services] > [Server] > [Admin] を選

択します）。

c. [Server] タブで、[Admin] > [Backup] を選択します。

ステップ 2 [Immediate for Frequency] を選択して、必要に応じて他のフィールドを設定し、[Apply] をクリックし

てデータをバックアップします。

CLI を使用したサーバ データベースのバックアップ

この項の手順では、サーバ上の Windows コマンドラインからスクリプトを実行することによって、

サーバ データベースをバックアップする方法について説明します。

データベースのバックアップ中に、Common Services と Security Manager の両方のプロセスがシャッ

トダウンされ、再起動されます。Security Manager の再起動が完了するまで数分かかるため、ユーザ

がその間にクライアントを開始する可能性があります。その場合は、デバイス ポリシー ウィンドウに

「error loading page」というメッセージが表示されます。

CiscoWorks サーバ上にインストールされたすべてのアプリケーションをバックアップするのに 1 つの

バックアップ スクリプトしか使用されません。個別のアプリケーションをバックアップできません。

ヒント このバックアップ コマンドはデータベースのみをバックアップします。イベント データ ストアをバッ

クアップする必要がある場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.4-17）に記載されているデータ ストア コピー手順を使用します。

ステップ 1 保留データがコミットされていることを確認します（「Security Manager の保留データが送信および承

認されることの保証」（P.4-12）を参照）。

ステップ 2 次のコマンドを入力することによって、データベースをバックアップします。

$NMSROOT¥bin¥perl $NMSROOT¥bin¥backup.pl backup_directory [log_filename 
[email=email_address [number_of_generations [compress]]]]

値は次のとおりです。

• $NMSROOT：Common Services インストール ディレクトリ（デフォルトは C:¥Program 
Files¥CSCOpx）のフル パス名。

• backup_directory：バックアップを作成するディレクトリ。C:¥Backups など。

• log_filename：（オプション）バックアップ中に生成されるメッセージ用のログ ファイル。現在の

ディレクトリ以外の場所で作成した場合のパスが含まれます。C:¥BackupLogs など。名前を指定

しなかった場合は、$NMSROOT¥log¥dbbackup.log になります。

• email=email_address：（オプション）通知を送信する電子メール アドレス。電子メール アドレス

は指定しないが、後続のパラメータは指定する必要がある場合は、サイズまたはアドレスが一致し

ない email を入力します。CiscoWorks Common Services で SMTP 設定を実施して通知をイネーブ

ルにする必要があります。
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• number_of_generations：（オプション）バックアップ ディレクトリに保存しておくバックアップ

の最大世代数。最大値に到達した場合は、古いバックアップが削除されます。デフォルトは、保存

しておく世代数が無制限になる 0 です。

• compress：（オプション）バックアップ ファイルを圧縮するかどうか。このキーワードを入力しな

かった場合は、バックアップ プロパティ ファイルで VMS_FILEBACKUP_COMPRESS=NO が指

定されていれば、バックアップが圧縮されません。そうでない場合は、バックアップが圧縮されま

す。バックアップは圧縮することを推奨します。

たとえば、次のコマンドは、perl コマンドと backup.pl コマンドが存在するディレクトリで発行するこ

とを想定しています。このコマンドは、backups ディレクトリに圧縮されたバックアップとログ ファ

イルを作成して、admin@domain.com に通知を送信します。圧縮パラメータを含めるようにバック

アップ世代を指定する必要があります。ログ ファイル パラメータの後ろにパラメータを指定した場合

は、先行するすべてのパラメータの値を含める必要があります。

perl backup.pl C:¥backups C:¥backups¥backup.log email=admin@domain.com 0 compress 

ステップ 3 ログ ファイルを調査して、データベースがバックアップされていることを確認します。

サーバ データベースの復元

コマンドラインからスクリプトを実行することによって、データベースを復元できます。データの復元

中に、CiscoWorks をシャットダウンして再起動する必要があります。この手順では、サーバ上でバッ

クアップされたデータベースを復元する方法について説明します。CiscoWorks サーバ上にインストー

ルされたすべてのアプリケーションをバックアップして復元するためのバックアップおよび復元ファシ

リティが 1 つだけ存在します。個別のアプリケーションをバックアップまたは復元できません。

複数のサーバ上にアプリケーションをインストールしている場合は、インストールされたアプリケー

ションに適切なデータが保存されたデータベース バックアップかどうかを確認してください。

ヒント

• バックアップが、このバージョンのアプリケーションへの直接ローカル インライン アップグレー

ドに対応したバージョンからのものである場合は、以前のリリースのアプリケーションから取得さ

れたバックアップを復元できます。アップグレードに対応したバージョンの詳細については、

「サーバ アプリケーションのアップグレード」（P.4-9）を参照してください。

• restore コマンドは、データベースのみを復元します。イベント データ ストアを復元する必要があ

る場合は、「新しいコンピュータまたはオペレーティング システムへの Security Manager の移行」

（P.4-17）に記載されているデータ ストア コピー手順を使用します。

手順

ステップ 1 コマンドラインで次のコマンドを入力することによって、すべてのプロセスを停止します。

net stop crmdmgtd 

ステップ 2 次のコマンドを入力することによって、データベースを復元します。

$NMSROOT¥bin¥perl $NMSROOT¥bin¥restorebackup.pl [-t temporary_directory]
[-gen generationNumber] -d backup_directory [-h]

値は次のとおりです。

• $NMSROOT：Common Services インストール ディレクトリ（デフォルトは C:¥Program 
Files¥CSCOpx）のフル パス名。
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• -t temporary_directory：（オプション）復元プログラムで一時ファイルを保存するために使用され

るディレクトリまたはフォルダ。デフォルトで、このディレクトリは 
$NMSROOT¥tempBackupData です。

• -gen generationNumber：（オプション）復元するバックアップ世代番号。デフォルトで、最新世代

です。第 1 ～ 5 世代が存在する場合は、第 5 世代が最新です。

• -d backup_directory：復元するバックアップが保存されたバックアップ ディレクトリ。

• -h：（オプション）ヘルプを表示します。-d BackupDirectory を使用した場合は、ヘルプに正しい

構文と使用可能なスイートおよび世代が表示されます。

たとえば、c:¥var¥backup ディレクトリから最新バージョンを復元するには、次のコマンドを入力しま

す。

C:¥Progra~1¥CSCOpx¥bin¥perl C:¥Progra~1¥CSCOpx¥bin¥restorebackup.pl -d C:¥var¥backup 

ヒント RME データが保存されたデータベースを復元している場合は、インベントリ データを収集す

るかどうかを尋ねられる場合があります。このデータの収集には長い時間がかかる可能性があ

ります。[No] を選択して、インベントリをスケジュールするように RME を設定することもで

きます。RME で、[Devices] > [Inventory] を選択します。

ステップ 3 ログ ファイルの NMSROOT¥log¥restorebackup.log を調査して、データベースが復元されていること

を確認します。

ステップ 4 次のコマンドを入力することによって、システムを再起動します。

net start crmdmgtd 

ステップ 5 Security Manager サービス パックをインストールする前にバックアップされたデータベースを復元す

る場合は、データベースの復元後にサービス パックを再適用する必要があります。

アップグレード後の必要な変更の実施

アプリケーションをアップグレードすると、特定の情報の処理方法が変わって、手動で変更しなければ

ならなくなる場合があります。このバージョンの製品にアップグレードしたら、下の必要な変更リスト

を参照して、状況に合わせて変更を適用する必要があります。

• 3.3.1 より以前のバージョンからアップグレードする場合は、4 ポート Gigabit Ethernet Fiber イン

ターフェイス カード（ハードウェア タイプ：i82571EB 4F）が実装された ASA 5580 デバイス上

でインベントリを再検出する必要があります。インベントリの再検出によって、デバイス上での速

度非ネゴシエート設定を変更できない以前のリリースからのバグが解決されます。インベントリを

再検出するには、Security Manager クライアントのデバイス ビューでデバイスを右クリックして、

[Discover Policies on Device] を選択してから、[Policies to Discover] グループ内の [Live Device 
discovery and only the Inventory] チェックボックスをオンにします。再検出によって、デバイスに

関するインターフェイス ポリシーが置き換えられます。

• 3.3.1 以前のバージョンからアップグレードしており、未サポートの Shared Port Adapter（SPA; 共
有ポート アダプタ）を使用する Cisco ASR 1000 Series Aggregation Services Router を管理してい

る場合は、Security Manager で、サポートされているバージョン 4.0 以降の SPA が検出できるよ

うに、デバイスに関するポリシーを再検出する必要があります。新しくサポートされる SPA には、

すべてのイーサネット（すべての速度）、シリアル、ATM、および Packet over Sonet（POS）SPA 
が含まれますが、サービス SPA は含まれません。デバイス CLI で ATM、PVC、またはダイヤラ

関連ポリシーを設定した場合は、再検出が必要です。
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Security Manager の移行

Security Manager を新しいサーバに移行しなければならない場合があります。この移行を新しい物理

コンピュータに対して行う場合と、サーバ上のオペレーティング システムにメジャー アップグレード

を施す場合（Windows 2003 から Windows 2008 に移行する場合など）があります。

Security Manager のバージョンは変更しないが、物理ハードウェアまたはオペレーティング システム

を変更する場合は、移行プロセスを通過する必要があります。この移行プロセスは、基本的に、「サー

バ アプリケーションのアップグレード」（P.4-9）に記載されているリモート バックアップ /復元アップ

グレード プロセスと同じものですが、Event Manager データ ストアに保存されたデータを移行する場

合は追加のステップが必要です。Security Manager サーバの移行を実施する場合は、この手順を使用

します。

（注） オペレーティング システムに対するマイナー サービス パック アップデートは、それが Security 
Manager サーバ移行要件になるまで、アップグレードとは見なされません。サーバ移行は、オペレー

ティング システムの正式名称が変更される場合のように、異なるメジャー バージョンのオペレーティ

ング システム同士を移行する場合に必要になります。

始める前に

この手順では、ターゲット サーバ（Security Manager を移行するサーバ）にソース コンピュータと同

じデータベースとイベント データ ストアの内容を保存するものとします。ターゲット サーバ上で 
Security Manager の使用を開始している場合は、ソース システムとターゲット システムのデータベー

スまたはイベント データ ストアをマージできません。ターゲット データをソース データで置き換える

必要があります。移行前にターゲット システム上に存在していたすべてのデータが、移行完了後に使

用できなくなります。古いターゲット システム データを新しく移行するフォルダにコピーしないでく

ださい。

また、イベント データ ストアのコピーおよび復元ステップは、そのデータを保存する場合にのみ必要

なことに注意してください。新しい空のイベント データ ストアから始める場合は、このステップを省

略できます。

ステップ 1 ソース Security Manager サーバ（移行元のサーバ）上で次の手順を実行します。

a. イベント データ ソース フォルダの名前を決定します。Security Manager クライアントを使用し

て、[Tools] > [Security Manager Administration] を選択し、目次から [Event Management] を選択

します。フォルダが [Event Data Store Location] フィールドに表示されます。デフォルトは、

NMSROOT¥MDC¥eventing¥database です。ここで、NMSROOT はインストール ディレクトリ

です（通常は、C:¥Program Files¥CSCOpx）。

b. コマンドラインで次のコマンドを入力することによって、すべてのプロセスを停止します。

net stop crmdmgtd 

c. NMSROOT¥MDC¥eventing¥config¥collector.properties ファイルのコピーとイベント データ ス
トア フォルダを作成します。そのコピーをターゲット コンピュータからアクセス可能なディスク

に配置します。

d. 「CLI を使用したサーバ データベースのバックアップ」（P.4-14）に記載されているコマンドライン

方式を使用して、Security Manager データベースをバックアップします。
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ステップ 2 新しいターゲット コンピュータを準備します。次の例を参考にしてください。

• オペレーティング システムをアップグレードするだけで、新しいハードウェアに移行しない場合

は、オペレーティング システム アップグレードを実施して、オペレーティング システムが正しく

機能していることを確認します。その後で、Security Manager をインストールします。

• 新しいコンピュータに移行する場合は、そのコンピュータが正しく機能していることを確認して、

Security Manager をインストールします。

ステップ 3 ターゲット Security Manager サーバ上で次の手順を実行します。

a. コマンドラインで次のコマンドを入力することによって、すべてのプロセスを停止します。

net stop crmdmgtd 

b. 「サーバ データベースの復元」（P.4-15）に記載されている手順を使用して、データベースを復元し

ます。

c. データベース復元の完了後にプロセスを再起動しなかった場合は、ここで再起動します。

net start crmdmgtd 

d. Security Manager クライアントを使用して新しいサーバにログインしてから、[Tools] > [Security 
Manager Administration] を選択して、目次から [Event Management] を選択します。

e. イベント データ ストア フォルダが存在し、それが空であることを確認します（必要に応じてファ

イルを削除します）。このフォルダには、ソース サーバ上のイベント データ ストアと同じ名前と

場所を設定する必要があります。

f. 正しい [Event Data Store Location]（デフォルトが正しいフォルダでない場合）を選択して、

[Enable Event Management] チェックボックスをオフにし、Event Manager サービスを停止しま

す。[Save] をクリックして変更を保存します。サービスを停止するかどうかの確認が要求されま

す。[Yes] をクリックしてサービスの停止が通知されるまで待ちます。

g. バックアップされたイベント データ ストアをソース コンピュータからターゲット サーバ上の新し

い場所にコピーします。

h. バックアップされた NMSROOT¥MDC¥eventing¥config¥collector.properties ファイルをソース 
コンピュータからターゲット コンピュータにコピーして、ターゲット サーバ上のファイルを上書

きします。

i. Security Manager クライアントを使用して、[Tools] > [Security Manager Administration] を選択

し、目次から [Event Management] を選択します。[Enable Event Management] チェックボックス

をオンにして、[Save] をクリックします。サービスを開始するかどうかの確認が要求されます。

[Yes] をクリックしてサービスの開始が通知されるまで待ちます。

Security Manager、Performance Monitor、および RME 
ライセンスの更新

インストール時に永久ラインセンス ファイルを指定できますが、Security Manager、Performance 
Monitor、または RME のインストール後にもライセンスを追加できます。他の Cisco Security 
Management Suite アプリケーションにはライセンスは必要ありません。

Security Manager のライセンス追加プロセスは、Performance Monitor や RME のプロセスと異なりま

す。次の手順では、両方のプロセスについて説明します。Performance Monitor/RME 共用ライセンス

は、Security Manager ライセンス ファイルとは別のファイルであることに注意してください。
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ライセンスの取得方法については、「インストールに対するライセンスの影響とライセンスの取得」

（P.1-6）を参照してください。

始める前に

ライセンス ファイルをサーバにコピーしてから、アプリケーションに追加します。

手順

Security Manager、Performance Monitor、または RME 用のライセンスをインストールするには、次

の手順を実行します。

ステップ 1 Security Manager ライセンスをインストールするには：

a. Security Manager クライアント アプリケーションを使用してサーバにログインします（「Security 
Manager クライアントを使用した Security Manager へのログイン」（P.5-10）を参照）。

b. [Tools] > [Security Manager Administration] を選択して、目次から [Licensing] を選択します。

c. タブがアクティブになっていない場合は、[CSM] をクリックします。

d. [Install a License] をクリックして、[Install a License] ダイアログボックスを開きます。このダイ

アログボックスを使用して、ライセンス ファイルを選択し、[OK] をクリックします。このプロセ

スを繰り返して他のライセンスを追加します。

ステップ 2 Performance Monitor または RME ライセンスをインストールするには：

a. Cisco Security Management Server デスクトップにログインします（「Web ブラウザを使用した

サーバ アプリケーションへのログイン」（P.5-11）を参照）。

b. [Server Administration] パネルをクリックします。[Server] > [Admin] タブで CiscoWorks 
Common Services が開きます

（CiscoWorks ホームページにログインした場合は、[Common Services] > [Server] > [Admin] を選

択します）。

c. [Licensing] を選択します。[License Information] ページに、ライセンス名、ライセンス バージョ

ン、ライセンスのステータス、およびライセンスの有効期限が表示されます。

d. [Update] をクリックして、[License] フィールドに新しいライセンス ファイルへのパスを入力する

か、[Browse] をクリックして新しいファイルを探します。

e. [OK] をクリックします。ライセンス ファイルが有効かどうか確認され、ライセンスが更新されま

す。更新されたライセンス情報が [License Information] ページに表示されます。

サービス パックとポイント パッチの入手

注意 Security Manager のサービス パックまたはポイント パッチは、シスコから入手してください。そ

うでないファイルをダウンロードしたり、開いたりしないでください。サードパーティ製のサービ

ス パックとポイント パッチはサポートされていません。

Security Manager またはその他のアプリケーションをインストールしたら、シスコシステムズから入

手したサービス パックまたはポイント パッチをインストールして、バグを修復したり、新しいデバイ

ス タイプをサポートしたり、アプリケーションを強化したりできます。
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• 新しいサービス パックの入手可能な時期を知って、必要なサービス パックをダウンロードするに

は、Security Manager を開いて、[Help] > [Security Manager Online] を選択します。または、

http://www.cisco.com/go/csmanager にアクセスします。

• 組織から Cisco TAC サービス リクエストが提出された場合は、TAC が、その問題の解決に役立つ

未公開のポイント パッチがあるかどうかを通知します。これ以外の方法で Security Manager ポイ

ント パッチが配布されることはありません。

サービス パックとポイント パッチは、クライアント ソフトウェア アップデートにサーバ サポートを

提供し、クライアントとサーバ間のバージョン レベルのミスマッチを検出します。

サーバ ホームページへのアプリケーションの追加
同じサーバ上に Cisco Security Management Suite アプリケーションがインストールされている場合は、

サーバ上のホームページにアプリケーションへのリンクが表示されます。ただし、複数のサーバ上にア

プリケーションがインストールされている場合は、アプリケーションを他のサーバに登録しなければ、

そのサーバのホームページにアプリケーションが表示されません。

1 つのホームページからすべての関連アプリケーションに接続できた方が便利な場合にのみこの作業を

行う必要があります。そうでない場合は、各サーバに直接ログインすることによって、アプリケーショ

ンを使用できます。サーバにログインしてホームページを開く方法については、「Web ブラウザを使用

したサーバ アプリケーションへのログイン」（P.5-11）を参照してください。

ステップ 1 Cisco Security Manager Suite のホームページで、[Server Administration] リンクをクリックします。

[Common Services Admin] ページが開きます。

ステップ 2 [Server] > [HomePage Admin] を選択して、目次から [Application Registration] を選択します。

[Application Registrations Status] ページが開きます。

ステップ 3 [Register] をクリックします。[Choose Location for Registrations] ページが開きます。

ステップ 4 [Register From Templates] を選択してから、[Next] をクリックします。

ステップ 5 ホームページにリンクするアプリケーション（[Monitoring, Analysis and Response System] や [RME]）
を選択してから、[Next] をクリックします。

ステップ 6 サーバ名、サーバ表示名、選択されたアプリケーションを実行しているデバイスに関するポートおよび

プロトコル情報を入力してから、[Next] をクリックします。

ステップ 7 登録情報を確認してから、[Finish] をクリックします。アプリケーションの起動点が Cisco Security 
Manager Suite のホームページに表示されます。

サーバ アプリケーションのアンインストール
この手順を使用して、サーバ アプリケーションをアンインストールします。アプリケーションをアン

インストールする前に、アプリケーションの再インストールが必要な場合にデータを復元できるように

バックアップの実施を検討してください。バックアップの実施方法については、「リモート アップグ

レード時のデータベースのバックアップ」（P.4-13）を参照してください。
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始める前に

任意のバージョンの Windows Defender がインストールされている場合は、それをディセーブルにして

からサーバ アプリケーションをアンインストールします。そうしなければ、アンインストール アプリ

ケーションを起動できません。

手順

サーバ アプリケーションをアンインストールするには、次の手順を実行します。

ステップ 1 [Start] > [Programs] > [Cisco Security Manager] > [Uninstall Cisco Security Manager] を選択します。

Performance Monitor と RME のどちらかだけがインストールされているサーバの場合は、[Start] > 
[Programs] > [Performance Monitor] > [Uninstall Performance Monitor] または [CiscoWorks] > 
[Uninstall CiscoWorks] を使用します。

ステップ 2 インストールされているアプリケーションのリストが表示されます。アンインストールするすべてのア

プリケーションを選択します。すべての Cisco Security Management Suite アプリケーションをアンイ

ンストールするつもりがない場合は、Common Services を選択しないでください。

Windows 2003 R2 Enterprise Server（Service Pack 2）（32 ビット）では、インストール プログラムか

ら Cisco Security Agent をアンインストールするかどうかが尋ねられます。

この方式では、外部 Cisco Security Agent はアンインストールできません（外部 Cisco Security Agent 
とは Cisco Security Manager インストールの一部としてインストールされない Cisco Security Agent の
ことです）。すべての Cisco Security Agent をアンインストールする場合は、[Start] > [Programs] > 
[Cisco Security Agent] > [Uninstall Cisco Security Agent] を選択します。詳細については、「同梱 Cisco 
Security Agent のアンインストール」（P.B-2）を参照してください。

ステップ 3 [Next] を 2 回クリックします。

アンインストーラによって、選択されたアプリケーションが削除されます。

（注） アンインストール中にエラーが発生した場合は、「アンインストール中のサーバ障害」（P.A-8）
と http://www.cisco.com/en/US/products/sw/cscowork/ps3996/prod_installation_guides_list.
html にある『Installing and Getting Started With CiscoWorks LAN Management Solution 3.1』
の「Troubleshooting and FAQs」の章を参照してください。

ステップ 4 リブートは必須ではありませんが、アンインストール後はサーバをリブートして、サーバ上のレジスト

リ エントリと実行中のプロセスが将来の再インストールに適切な状態になるようにすることを推奨し

ます。

ステップ 5 Common Services を含むすべての Cisco Security Management Suite アプリケーションをアンインス

トールする場合のみ：

a. NMSROOT が残っている場合は、それを削除、移動、または名前を変更します。NMSROOT は 
Security Manager インストール ディレクトリへのパスです。NMSROOT のデフォルト値は 
C:¥Program Files¥CSCOpx です。E:¥Program Files¥CSCOpx などのその他の値も使用できま

す。

b. C:¥CMFLOCK.TXT ファイルが存在する場合は、それを削除します。
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c. アプリケーションを再インストールする前に、レジストリ エディタを使用して、これらのレジス

トリ エントリを削除します。

• My Computer¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco¥Resource Manager

• My Computer¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco¥MDC

ステップ 6 アプリケーションをアンインストールする前に Windows Defender をディセーブルにした場合は、ここ

で、もう一度イネーブルにします。
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